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Processing data with Mestrelab Mnova 
 
Mnova provides an interface for processing and plotting NMR data.  It starts with Varian or Bruker data as 
received from the spectrometer, but it converts data to its internal format silently. It does not separate 
processing and plotting, so all work is done in a WYSIWYG format and you can immediately make a high-
quality PDF out of it.  Changes in data processing are not reflected in the original fi les; you must save your 
work as an Mnova file to be able to return to it. 
 

An excellent guide for starting with Mnova, slightly more advanced than this one and with more detail, is 
the Mnova Suite – starting guide available from http://mestrelab.com/help-by-plugin/ (or go to the Mnova 
home page and browse to Learn & Support / Help by Plugin).  There is also information there about other 
components such as reaction monitoring and NMR prediction.  Note that the interface changed between 
Mnova 11 and Mnova 12 so the screenshots look different.  However, the capabilities are basically the 
same. 
 
Also, Mestrelab ran a very good series of workshops during lockdown.  These are available at 
https://mestrelab.com/free-practical-training-series/.  They all include data for practicing on. 

Exercise 1: The Mnova interface 
1. Download the five files linked to from https://mcgill.ca/mc2/using-mc2/workshops/workshop-

information, under Processing Workshop.  You may wish to think a bit about how you will organize your 
data.  Although you can drag and drop any NMR dataset into Mnova, regardless of where it is saved, 
Mnova has a data browser which allows you to browse through your directories and access zipped and 
unzipped NMR data easily. 

 
2. Turn the data browser on by going to the View flowbar and selecting Data Browser.  Click on the Plus 

sign icon and add the directory where you have saved your data.  You should see the zipped files there 
(or the unzipped files, if they were automatically unzipped already). 

 
3. Note: if you see menus at the top rather than flowbars, you are running with the Classic Theme.  To 

change to the Modern Theme, which is recommended, go to the Edit menu and choose Preferences.  
Under Interface, choose Modern for the theme.  You will then have to restart Mnova.   

4. To view a dataset, drag and drop it from the databrowser onto the sheet in the middle of the window.  
You may find it useful to create multiple documents, which you can do by typing Ctrl -N or using the File 
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menu.  As you go, don’t forget to save your work.  You can also drag and drop zipped files from 
anywhere on your computer and they will open directly. 

5. Open the dataset Nicotinamide_Liquid_DMSO/1 by dragging and dropping it from the data 

browser onto the spectrum window.  The data should be processed automatically. 

6. To find out information about acquisition, go to the View flowbar and click on Parameters.  Use 

the window that opens to answer the following questions: what instrument was used to acquire 

the spectrum?  How many scans were acquired?  What was the relaxation time?  You can change 

the comment appearing by default in the upper left of the spectrum.  Simply type something 

different in the Comment box.  

7. When a spectrum is acquired on a spectrometer, various parameters governing processing are 

saved with it.  Mnova can be set to use these parameters.  Go to File and Preferences.  Click on 

the NMR icon at the top of this window, then go to Import.  Choose Apodi zation (which sets the 

line broadening), Zero Filling (which adds zeroes at the end of an FID, improving its resolution), 

and Linear Prediction (which helps with the baseline of solid-state NMR spectra and with 

narrowing signals in the indirect dimension of a 2D spectrum). 

8. You can draw molecules or open .mol files in Mnova to add them to your figure or work on 

assigning signals on them (see below).  Drag and drop the .mol file nicotimide.mol in from the 

data browser. 

9. Play around with Mnova: type Z to zoom in horizontally on a spectrum by clicking and dragging 

horizontally.  Type Z again to zoom vertically, and type Z a third time to zoom in both vertically 

and horizontally.  Type Esc to exit zoom mode (or any other mode).  Use the mouse wheel, 

touchpad gestures, or the keys + and - to scale up and down vertically. Type F to view the entire 

spectrum.  Other tools are available in the View toolbar – for example, you can specify exactly 

what region to zoom in on. 

10.  Right-click and choose Properties to change the appearance of the spectrum.  Some ideas: 

 NMR Spectrum / Scales / Vertical: remove the vertical scale 

 NMR Spectrum / 1D: change the color of the spectrum.  Just click on the drop down menu 

with the box next to Color 

 NMR Spectrum / Scales / Horizontal: set the horizontal scale to $^1n$ ($u$) to show the 

nucleus under spectrum 

 NMR Spectrum / Grid: activate the grid by selecting Show Horizontal and/or Show Vertical; 

also play with the colour 

 Geometry: set an exact size – this is useful when making figures for publications 

 NMR Spectrum / Title: Change which part of the title or comment appears on the spectrum, 

or deselect it entirely 

11.  Once you have a look you are happy with, click on Set as Default, and you’ll be able to use it in the 

future.  You can also save as many sets of settings as you like, using the floppy disk save icon at the 

top.  Then you can reuse them by opening them again.  For example, I set most of my colours to 

black and some to gray so that my figures will be black and white by default, but I also have saved 

options with colors. 

12.  To save your work, create an Mnova file using the floppy disk icon in the upper left.  If you save it 

in a directory listed in the data browser, you will be able to retrieve it very easily.  
13. Export the spectrum as a PDF file by going to File / Export to PDF. 
14.  Save the file as a csv file, readable by Excel or other plotting programs, by going to File / Save 

As... and setting the type to NMR CSV file. 
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Exercise 2: Processing and plotting a 1D dataset 
1. Be sure that the spectrum Nicotinamide_Liquid_DMSO/1 is loaded.  If not, drag and drop it from 

the data browser onto the spectrum window.  The data should be processed automatically.  

2. Have a look at the FID.  Under the Processing flowbar, select FT1 and choose Original FID.  

Occasionally, you will see something interesting here, like a quickly decaying signal followed by a lot 

of noise, suggesting that the FID should be truncated before processing, in order to increase the 

signal-to-noise ratio.  This is particularly useful for solid-state NMR.  Go back to the spectrum by 

choosing Spectrum After 1st FT. 

3. Play with apodization or window functions – type W to open the window function window.  The 

simplest function is Exponential line broadening, which multiplies the FID by a decaying 

exponential.  This gives extra weight to the beginning of the FID, which contains information about 

signal, and discounts the end of the FID, which contains more noise (and also information about 

resolution, so if too much line broadening is applied, you will lose small couplings).  Play with the 

line broadening value: what do you like? 

4. Check the phasing.  Mnova usually phases and corrects the baseline automatically and this is often 

very good.  To check it, expand the spectrum vertically so you can see right into the  baseline.  If the 

baseline isn’t level at the base of all the signals, then you should try auto phasing by clicking on 

Processing / Auto Phase Correction.  If this doesn’t do the trick, then undo any baseline correction 

that has already been done by clicking on Processing Template, deselecting Baseline Correction, 

and clicking OK. 

 

Now try Automatic Phasing again.  If this still isn’t good enough, click on Manual Correction.  A 

window will appear.  Move the pivot point to the DMSO signal (because it is on one end of the 

spectrum) by sliding the slider until the blue line is on top of the DMSO signal.  Click and hold with 

the left mouse button and drag it forward and backward until the DMSO peak is perfect.  Ignore the 

other signals.  Now click and hold, then drag with the right mouse button until the other signals are 

perfect also. 

5. Correct the baseline with the Auto Baseline Correction button.  This algorithm is usually very good 

and needs no modification. 

6. Reference the spectrum.  The spectrometers use the deuterium signals from the solvents to 

reference, but they also sometimes look for TMS and if they find any signal, like vacuum grease, 

around 0 ppm, they will put this signal at 0 ppm. So it is sometimes necessary to rereference.  Go to 

Analysis and click on Reference.  Select a peak and enter the chemical shift you want it to have.  If 

you choose the solvent signal, click on Solvents to see a list of standard solvent chemical shifts.  
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7. Remember to save your work with the floppy disk icon.  This will prompt you to create an Mnova file. 

8. Start your analysis of the spectrum by going to the Analysis flowbar and clicking on Auto Multiplet 

Analysis.  This routine detects signals, divides them into multiplets, and integrates the multiplets.  It 

is not perfect, but it is usually a good starting point.  Note that Mnova labels the water and residual 

DMSO-d5  signals.    Once Mnova has detected multiplets, you should look at them.  You may wish to 

play with the manual multiplet buttons, to hover over the integral lines, right-click, and Edit the 

Multiplet to change its description, the number of protons you believe it corresponds to, or the peaks 

selected. Sometimes deleting a multiplet and selecting it manually can be useful.  The Report 

Multiplets icon, and the Copy Multiplets icon are very helpful.   To gain an idea of how Mnova 

determines the multiplicity of a multiplet and how it defines its integral regions, right-click and 

choose Properties.  Under peaks, choose Curve, and turn on Peaks.  This shows the peak 

deconvolution. 

9. To report the multiplets for publication, click on the icon “Report Multiplets”.  To customize the 

report, go to the multiplets table (via the icon) and choose Setup Report / Setup Report.  

10.  To separate out the processes of peak picking and integration, you can use those portions of the 

analysis toolbar.  Useful keyboard shortcuts: K for peak picking (click to drag a box over the tops of 

signals you want to select) and I for integration (click and drag across signals).  Right-clicking on an 

integral allows you to normalize it.  There are options next to Auto Peak Picking and Auto Integration 

to see the peak and integral tables, respectively – these can be selected and copied for use in other 

program. 

11.  If you haven’t already, drag and drop the nicotinamide mol file from your Downloads folder into 

Mnova, or go to Molecule / Draw to draw it, or go to Molecule / Tools / Molecule search (on the far 

right) to find it.  Once you’ve got it, go to Analysis / Auto Assignment to do assignments.  This works 

well for this simple molecule, but is likely to be less successful for anything more complicated!  To 

make manual assignments, use the shortcut A, then drag and drop between multiplets and the 

molecule to make assignments. 

12.   Play around with other tools, such as Prediction.  This is not guaranteed, but it is useful!  

 

Exercise 3: Dealing with multiple 1D spectra 
1. Start a new document by typing Ctrl-N or going to the File menu. 
2. Read in and process each of the three spectra we will use for the exercise: 

20160921_B400_Strychnine_sealed, 20160921_B500_strychnine_sealed, and 
20160921_M300_Strychnine_sealed_PROTON_01.fid.  These used the default parameters on each 
spectrometer to compare sensitivity on the same sealed sample of strychnine in CDCl3.  Roughly 3.5 mg 
of strychnine was in the sample.  Be sure the spectra are phased and the baselines are correct.  Check 
that the residual CHCl3  signal has the same chemical shift in all spectra.  If not, use Analysis / Reference 
/ click on the CHCl3  signal / Solvents >> / CDCl3 until they are all the same.  

3. Integrate one of the spectrum using the I shortcut, then clicking and dragging across the signals of 
interest. 

4. Hit Esc to escape from integrate mode, then right-click and choose Copy 
5. Select a different spectrum (on a different page).  To copy the integrals (only), go to the Home flowbar, 

select the arrow under the Paste icon, and choose NMR Integrals.  Only the integrals will be brought in 
from the previous spectrum. 
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6. Now select all three pages by holding down Shift and click on each page in the Pages panel which is 
usually on the left side of the Mnova window.  If you do not see it, go to View / Pages. 

7. Once more than one spectrum is selected, a new menu appears at the top of the screen: Stacked.  Go 
to Stacked and choose Stack Items or Superimpose Items.  This creates a new page with all three 
spectra displayed on it.  You can change the style by going to Stacked / Mode.  If you zoom in, for 
example (Z), you will zoom in on all spectra.  The simplest way to adjust the vertical scale is by clicking 
on Stacked / Auto Scale, but you can also adjust each spectrum individually using Adjust Stacked Items.  

8. As usual, double-click on the page to customize its appearance.  The y axis, for example, is only rarely 
useful.  Note that often one spectrum is highlighted by Mnova. This is the active spectrum and 
sometimes the concept of the active spectrum is useful for modifying just one single spectrum.  The 
highlight does not plot. 

9. This will not be covered fully here, but it is interesting to learn how to integrate or plot the  peak 
intensity of all spectra displayed on a stacked spectrum.  To do this, go to Data Analysis / New / 
Integrals Graph.  Now integrate a region by dragging and dropping over it.  This isn’t, perhaps, useful 
here (data acquired on different spectrometers is usually scaled very differently and the integrals can’t 
be compared directly), but in other cases, such as kinetics, it is very useful. 

Exercise 4: Processing a 2D spectrum and plotting a 2D spectrum with a 1D 
spectrum as a projection 
1. Start a new document by typing Ctrl-N or going to the File menu. 
2. Drag and drop the spectra V500_Strychnine_1H.fid and V500_Strychnine_gc2hsqcse_01.fid from the 

data browser onto the pages at the right. The spectra are processed automatically.  Mnova recognizes 
that the 1D spectrum is a proton spectrum and pastes it at the top of the 2D spectrum to aid in 
interpreting it. 

3. Go back to the 1D spectrum and check the phasing and baseline. 
4. If you change the 1D spectrum and want the view to update in the 2D spectrum, you have to set it up 

manually.  Go to View and choose the Setup 2D Traces icon ( ). Choose the bottom option, Setup.  
The 1D spectrum is listed on the left.  Select it, then click on the checkmark under Horizontal Trace.  
This will cause the spectrum shown on the 2D graph to update.  This technique is also very useful if you 

have multiple 1D spectra open when you bring in a 2D spectrum, or if you want to plot a 13C spectrum 
on the vertical axis. 

5. Phasing.  The 13C HSQC (the 2D spectrum) shows 1H signals correlated to 13C signals that come from 

carbons one bond away from the protons.  All signals should either be positive (CH or CH3) or negative 

(CH2).  The signs are indicated by colors.  To phase the spectrum, go to Processing and click on Auto 
Phase Correction.  Usually this does a good job, but if you want to phase manually, click on Manual 
Correction and phase first the direct or horizontal dimension (F2), then the indirect or vertical 
dimension (F1) using the same techniques as for 1D spectra (highlighting a large signal on one end of 
the spectrum and using zero order phasing to correct it, then correcting the rest with first order 
phasing). 

6. Baseline correction.  If there are horizontal or vertical bands of noise in the spectrum, use the auto 
baseline correction button to remove them.  This is more common in NOESY spectra than HSQC, unless 
there has been a problem with acquisition.  Strong vertical bands can be removed with the Processing / 
More processing / Reduce t1 noise option. 

7. Linear prediction.  In 2D spectra, the vertical dimension ( 13C here) is usually acquired with very few 
points (say 256) relative to a normal 1D spectrum (often 32000 points). This saves time, but it means 
that resolution is poor, since only a few points are used to describe the spectrum.  To linearly predict 
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the data in the vertical (or F1 or indirect) dimension, select F1 under processing and then click on Zero 
Filling and LP. 

Select Forward to turn on forward linear prediction (you can accept the default parameters, which are 
taken from the spectrometer, although sometimes the number of points predicted is too high – for best 
results, the “to” number should be double the  “from” number, and sometimes the default is much 
higher, especially with Varian datasets. 
 
To make Mnova apply linear prediction parameters automatically when i t reads data in, go to the 
settings (upper right corner), go to NMR, then to Import, and be sure that “Linear Prediction” (under 
Parameters) is selected.  Save this. 

8. As you did with the 1D spectrum, right-click and choose Properties on the 2D spectrum to customize 
the appearance.  One very useful setting for 2D spectra is the appearance of the contour levels, under 
2D.  I tend to use 32 positive and 32 negative levels, with a spacing of 1.2  Play with the color, the 
spacing between the contour levels, and the number of contour levels.  Use Apply to see the effect of 
your changes.  Once you make your spectrum look like you want, set your settings as default and/or 
save them. 

9. Save your work and make a PDF. 
 


